
 

 

โรงเรียนตาพระยา  อ าเภอตาพระยา  จังหวัดสระแก้ว  ส านักงานเขตพื้นท่ีการศึกษามัธยมศึกษา  เขต 7 หน้า 123 

 

แอนิเมชัน (Animation) เป็นการสร้างออบเจ็กต์ให้มีการเคลื่อนไหว มักนิยมใช้ประกอบในชิ้นงาน
ทั่วไป ไม่ว่าจะเป็นเว็บเพจ, เกม , หรือเอกสารสมัยใหม่ โปรแกรม Flash ที่เราก าลังใช้อยู่นี้ เป็นโปรแกรมที่ดี
โปรแกรมหนึ่งที่สามารถสร้างงานแอนิเมชันได้อย่างง่ายดาย และน าไปใช้กันอย่างแพร่หลาย 
 ส าหรับในเรื่องนี้เราจะได้เรียนรู้ขั้นตอนการสร้างแอนิเมชันในรูปแบบต่างๆ ทั้งหมด เช่น หากต้องการ
น าออบเจ็กต์หรือภาพหลายๆ ภาพมาเรียงต่อกันเป็นผลงานแอนิเมชันก็สามารถท าได้ด้วย Frame by Frame 
เมื่อต้องการสร้างแอนิเมชันให้มีการเคลื่อนไหวสามารถท าได้ด้วย Classic Tweening หากมีออบเจ็กต์ตั้งแต่ 2 
ชิ้นและต้องการแปลงจากชิ้นหนึ่งเป็นอีกชิ้นหนึ่งให้ใช้ Tweening Shape หรือต้องการสร้างแอนิเมชันให้
เคลื่อนไหวไปตามเส้นไกด์สามารถท าได้ด้วย Guide Layer และการสร้างแอนิเมชันในลักษณะ Mask Layer 
ใช้ในกรณีเมื่อต้องการสร้างผลงานแอนิเมชันในลักษณะเหมือนมีแสงไฟก าลังหมุนและส่องลงบนภาพ 

การสร้างแอนิเมชันในลักษณะ Frame by Frame  เราจะต้องมีออบเจ็กต์ ภาพ หรือไฟล์งาน 
ตั้งแต่ 1 ไฟล์เป็นต้นไป และท าการ Insert Keyframe เพ่ือแทรกข้อมูลแต่ละชิ้นลงในคีย์เฟรม หลังจากได้
แทรกข้อมูลเรียบร้อยแล้ว จึงท าการทดสอบการแสดงผล โปรแกรมก็จะท าการเล่นแสดงข้อมูลทั้งหมดให้อย่าง
ต่อเนื่องจนกลายเป็นผลงานแอนิเมชันขึ้นมา ซึ่งสามารถเปรียบเทียบการท างานได้กับการท างานของฟิล์ม
ภาพยนตร์จะท าการฉายเฟรมหนังแต่ละเฟรมจนกลายเป็นภาพยนตร์ขึ้นมา 
 ในที่นี้ เราจะมาลองสร้างภาพผีเสื้อบิน ซึ่งทุกๆ เฟรมจะเปลี่ยนท่วงท่าและต าแหน่งไปดังรูป 
 

 
 
            1. เลือกที่เลเยอร์ที่จะสร้างภาพเคลื่อนไหวแล้วคลิกท่ีเฟรมในเลเยอร์นั้นที่จะเริ่มสร้างในที่นี้ 
ให้สร้างไฟล์ใหม่ และคลิกท่ีเฟรมแรกของ Layer 1 
 

เฟรม 1 
เฟรม 6 

เฟรม 3 

เฟรม 2 
เฟรม 4 

เฟรม 5 
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 2. หากเฟรมนั้นยังไม่เป็นคีย์เฟรม ให้เลือกเมนูค าสั่ง Insert เลือกค าสั่ง Keyframe  

 
 

 3. สร้างภาพแรกของการเคลื่อนไหวขึ้นในเฟรมนั้น โดยอาจวาดขึ้นเองหรือน าจากไฟล์อ่ืนเข้ามาใช้
ด้วยเมนคู าสั่ง File เลือกค าสั่ง Import ก็ได้ 
 4. คลิกท่ีเฟรมถัดไป แล้วเลือกเมนคู าสั่ง Insert เลือกค าสั่ง Keyframe  
 5. สร้างภาพถัดไปของการเคลื่อนไหวหากน าเข้าจากไฟล์ อย่าลืมลบรูปเก่าออกด้วย 
 6. ท าขั้นตอนที่ 4 และ 5 ซ้ าจนครบทุกเฟรมของการเคลื่อนไหว 
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เลือกเมนูค าสั่ง Control  เลือกค าสั่ง Play เพ่ือดูผล และก็บันทึกภาพเก็บไว้ในชื่อ Butterfly   
 

 Onion skinning เป็นส่วนที่ช่วยให้เราสามารถเห็นภาพในเฟรมก่อนหน้าหรือหลังเฟรมขณะนั้น หรือ
ทุกๆ เฟรมพร้อมๆ กันได้ โดยไม่ต้องไปเลือกเฟรมกลับไปกลับมา ท าให้สามารถปรับแต่งภาพในแต่ละเฟรมให้
มีการเคลื่อนไหวอย่างนุ่มนวลได้อย่างสะดวก 
 ส่วนของ Onion skinning นี้จะอยู่ในตอนล่างของพาเนล Timeline  
 
 
 
 
 
 
 
 
 

การขอดูหลายๆ เฟรมพร้อมกัน 
1. คลิกท่ีเฟรมหลักท่ีจะดู 
2. คลิกท่ีปุ่ม  Onion Skin 
โปรแกรมจะแสดงภาพในเฟรมก่อนหน้าเฟรมนั้นให้ หากต้องปรับจ านวนเฟรมท่ีจะดู ให้ 

ลากส่วนของ Start Onion Skin และ End Onion Skin marker ซึ่งอยู่ในแถบหัวของพาเนล Timeline  

Onion Skin  
Onion Skin Outlines 

Edit Multiple Frames 

Modify Onion 
Markers 
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 การแสดงกรอบเฟรมแทนภาพ ให้คลิกที่ปุ่ม  Onion Skin Outlines หากต้องการปรับต าแหน่ง
ภาพในเฟรม ให้ลากกรอบเฟรมนั้น หากต้องการแก้ไขภาพในเฟรมใดๆ ก็ได้ ให้คลิกที่     Edit Multiple 
Frames  
 

 
 
 
 
 
 
 
 

Start Stop 
Onion Skin 
Marker 

Onion Skin 
Outlines 
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คลิกท่ีปุ่ม  Modify Onion Marker แล้วลักษณะการแสดงผลจากเมนู  
 
 
 
 
 
 
 
 
 
 
 

แสดง Onion Skin Marker ในแถบหัวของพาเนล Timeline ตลอด
ไม่ว่าจะเลือกใช้ Onion Skinning หรือไม่ก็ตาม 

ล็อคไม่ให้ Onion Skin Marker เลื่อนตามเฟรมที่เลือก 

แสดง 2 เฟรมก่อนหน้าและถัดไปจากเฟรมที่เลือก 
แสดง 5 เฟรมก่อนหน้าและถัดไปจากเฟรมที่เลือก 
แสดงทุกเฟรม 

Edit Multiple Frames 

คลิกทีเ่ฟรมที่จะแก้ไขแล้ว
คลิกปุ่ม Edit  
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การสร้างแอนิเมชันในลักษณะ Classic Motion Tweening คือ การสร้างแอนิเมชันโดยใช้ออบเจ็กต์เพียง 
ชิ้นเดียว จากนั้นจึงสั่งให้มีการเคลื่อนไหวและการเปลี่ยนแปลงเกิดขึ้นมาท่ีออบเจ็กต์นั้น 
      ดังตัวอย่างต่อไปนี้จะท าการสร้างแอนิเมชันในลักษณะ Classic Tweening คือ ให้รถมีการแล่นมาถึง
เฟรมที่ 5 และมีขนาดใหญ่ขึ้น จากนั้นในเฟรมที่ 10 ให้จานบินคันนี้มีขนาดเล็กลง ถูกหมุนกลับด้าน และมีสี
ลดลงไปจากเดิมส าหรับขั้นตอนการท างานสามารถท าได้ ดังนี้ 

1. สร้างออบเจ็กต์ (รูปรถ) ไว้ในเฟรมที่ 1  
2. คลิกขวาเฟรมที่ 5 และเลือกค าสั่ง Insert Keyframe เฟรมทั้งหมดจะมีความยาวจ านวน 5 เฟรม 
3. คลิกขวาเฟรมที่ 10 และเลือกค าสั่ง Create Classic Tween เพ่ือสร้างการเคลื่อนไหวจนถึงเฟรม

ที่ 10 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 

2.สร้างออบเจ็กตไ์ว้ในเฟรมที่ 10
และ เลือกค าสั่ง Insert keyframe 

1.สร้างออบเจ็กตไ์ว้ในเฟรมที่ 1 

3.คลิกเมาส์ขวาเฟรมที่ 10 และเลอืก
ค าสั่ง Create Classic Tween 



 

 

โรงเรียนตาพระยา  อ าเภอตาพระยา  จังหวัดสระแก้ว  ส านักงานเขตพื้นท่ีการศึกษามัธยมศึกษา  เขต 7 หน้า 129 

 

4. เลื่อนวัตถุลงมาข้างล่างและคลิกปุ่ม Free Transform Tool  ที่ทูลบ็อกซ์ 
5. ดรากส์เมาส์ท าการขยายขนาดตามต้องการ 
6. คลิกเมาส์ขวาเฟรมที่ 15 และเลือกค าสั่ง Insert Keyframe จากนั้นจะปรากฏคีย์เฟรมข้ึนมาบน

เฟรมที่ 15 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. ดรากส์เมาส์ท าการย่อขนาดให้เล็กลงไปจากเดิม 
8. คลิกเมนูค าสั่ง Modify เลือกค าสั่ง Transform  เลือกค าสั่ง  Flip Horizontal จากนั้นออบเจ็กต์ 

จะถูกหมุนกลับด้านไป 
9. คลิกหน้าต่างค าสั่ง Properties  

5.ดรากสเ์มาส์ท าการขยายขนาด 

4.คลิกปุ่ม Free Transform Tool 

6.คลิกเมาส์ขวาเฟรมที่ 15 และ เลือก
ค าสั่ง Insert Keyframe 
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10. ที่ Color ให้คลิกเลือก Alpha จากนั้นออบเจ็กต์ จะมีสีลดลงไปจากเดิม 
11. คลิกขวาที่ keyframe  ที่ 15 เลือก Create Classic Tween 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.คลิกเมนู Modify > Transform 
> Flip Horizontal 

7.ดรากสเ์มาส์ท าการย่อขนาด 

9.คลิกหน้าต่าง Properties 

10.คลิกเลือก Alpha  

ปรับค่า Alpha ตามต้องการ 
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จากนั้นลองทดสอบภาพแอนิเมชันที่เราสร้างข้ึนมาโดยการ กด <Ctrl+Enter> 
 

การสร้างแอนิเมชันในลักษณะ Tweening Shape คือ การสร้างแอนิเมชันโดยใช้ออบเจ็กต์ หรือ 
ภาพ 2 ชิ้นโดยชิ้นแรกจะวางอยู่ที่ต าแหน่งเริ่มต้นของเฟรม และอีกชิ้นหนึ่งจะวางอยู่ที่ต าแหน่งสุดท้ายของ
เฟรม จากนั้นจึงสั่งให้มีการ รวมออบเจ็กต์ หรือภาพท้ัง 2 ชิ้นเข้าด้วยกัน และเม่ือท าการแสดงผลภาพหนึ่งก็จะ
แปลงกลายเป็นอีกภาพหนึ่ง  

ดังตัวอย่างต่อไปนี้จะท าการสร้างแอนิเมชันในลักษณะ Tweening Shape โดยเริ่มแรกจะน า 
ออบเจ็กต์ที่ 1 ไว้เฟรมที่ 1 และท าการ Insert Keyframe เพ่ือวางออบเจ็กต์ที่ 2 ไว้ในเฟรมที่ 10 จากนั้นจะ
รวมออบเจ็กต์ทั้ง 2 เข้าด้วยกัน เมื่อท าการเล่นแสดงแอนิเมชัน จากออบเจ็กต์ที่ 1 จะกลายเป็นออบเจ็กต์ที่ 2 
ให้โดยอัตโนมัติส าหรับขั้นตอน การท างานสามารถท าได้ดังนี้ 

1. สร้างออบเจ็กต์ ไว้ในเฟรมที่ 1 
2. คลิกเมาส์ขวาเฟรมที่ 10 และเลือกค าสั่ง Insert Keyframe จากนั้นจะปรากฏคีย์เฟรมข้ึนมาบน

เฟรมที่ 10  
3. เปลี่ยนรูปทรงใหม่ให้แตกต่างจากรูปภาพที่อยู่ใน เฟรมที่ 1  
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4. คลิกหน้าต่างค าสั่ง Properties คลิกที่ Tween ให้คลิกเลือก Shape จากนั้นเมื่อท าการแสดงผล
ออบเจ็กต์ท่ี 1 จะถูกรวมและแปลงเป็นออบเจ็กต์ที่ 2 ให้โดยอัตโนมัติ  

 
 
 
 
 

1.สร้างออบเจ็กตไ์ว้ในเหรมที่ 1 

2.คลิกเมาส์ขวาเฟรมที่ 10 และ   
   เลือกค าสั่ง Insert Keyframe 

3. เปลี่ยนรูปทรงใหม่ให้แตกต่างจาก
รูปภาพเดิม 
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จากนั้นลองทดสอบภาพแอนิเมชันที่เราสร้างข้ึนมาโดยการ กด <Ctrl+Enter> 
 
 
 
 
 
 
 
 
 

การสร้างแอนิเมชันในลักษณะ Guide Layer คือ การสร้างแอนิเมชันโดยให้ออบเจ็กต์ 
เปลี่ยนแปลงเคลื่อนที่ไปตามเส้นไกด์ ส าหรับขั้นตอนการสร้างแอนิเมชันในลักษณะนี้ จะต้องท าการคลิกปุ่ม 
Add Classic Guide ที่ไทม์ไลน์จากนั้นสร้างเส้นไกด์ท่ีใช้ในการควบคุมทิศทางการวิ่งของออบเจ็กต์ข้ึนมา 

ดังตัวอย่างต่อไปนี้จะท าการสร้างแอนิเมชันในลักษณะ Guide Layer คือ ให้ใบไมไ้ป 
ตามเส้น Guide ทีไ่ด้วาดไว้  

5.คลิกเลือก Create shape tween 

การแสดงผลออบเจ็กต์ที่ 1 
จะถูกรวมและแปลงเป็น
ออบเจ็กต์ที่ 2 
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1. สร้างออบเจ็กต์ ไว้ในเลเยอร์ที่ 2 
2. คลิกเมาส์ขวาเฟรมที่ 20 และเลือกค าสั่ง Insert keyframe เฟรมทั้งหมดจะมีความยาวจ านวน 

20 เฟรม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. คลิกเมาส์ขวาที่เฟรมที่ 20 และเลือกค าสั่ง Create Classic Tween  เพ่ือสร้างการเคลื่อนไหว
จนถึงเฟรมที่ 20 

 
4. คลิกขวาที่ เลเยอร์ 2 เลือกค าสั่ง   Add Classic Guide ที่ไทม์ไลน์ จากนั้นจะปรากฏเลเยอร์ใหม่ 

ขึ้นมาจ านวน 1 เลเยอร์ สามารถสังเกตได้ว่า Layer 2 ได้ถอยเยื้องเข้าไป 1 แท็บ ซึ่งหมายถึง 
Layer 2 ได้ถูกไกด์เรียบร้อยแล้ว  

 

2.คลิกเมาส์ขวาเลือกค าสั่ง 
Insert keyframe 

1.สร้างออบเจ็กต์ 
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5. คลิกปุ่ม Pencil Tool ที่ทูลบ็อกซ์  
6. ดรากส์เมาส์สร้างเส้นพาธที่ต้องการให้เป็นแนววิ่งของออบเจ็กต์ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. คลิกปุ่ม Arrow Tool    ที่ทูลบ็อกซ์ 
8. ดรากส์เมาส์ย้ายออบเจ็กต์มาไว้ยังต าแหน่งสุดท้ายของเส้นไกด์ 

 
 
 
 
 

5.คลิกปุ่ม Pencil Tool 

4.คลิกขวาเลือกค าสั่ง Add 
Classic Guide 

6.ดรากสเ์มาส์สร้างเส้นพาธ 
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 จากตัวอย่างท่ีผ่านมาเม่ือทดสอบดูการเคลื่อนที่ของออบเจ็กต์ทั้งหมด จะสังเกตเห็นว่าออบเจ็กต์มีการ
เคลื่อนที่ไปตามเส้นไกด์ในทิศทางแนว 180 องศา ซึ่งท าให้ดูไม่สมจริงเท่าท่ีควร 
 ดังนั้นคุณสามารถสั่งค าสั่ง Orient to path เพ่ือให้ออบเจ็กต์เคลื่อนที่ไปตามเส้นพาธที่สร้างขึ้น 
จากนั้นจึงท าการหมุนออบเจ็กต์ให้เอียงไปตามทิศทางการเคลื่อนที่ของเส้นพาธ และเมื่อท าการทดสอบการ
แสดงผลแอนิเมชัน ผลงานที่สร้างขึ้นก็จะมีการเคลื่อนที่ได้อย่างสมจริงมากขึ้น 

1. คลิกเมนูค าสั่ง  Window เลือกค าสั่ง Properties ให้ปรากฎเครื่องหมายถูก 
2. คลิกเฟรมที่ 1 ของ Layer 1 เพ่ือเลือกออบเจ็กต์ ต าแหน่งแรกสุด ขณะที่อยู่ในเลเยอร์ 2  
3. คลิกให้ปรากฏเครื่องหมายถูกที่ Orient to path เพ่ือให้ออบเจ็กต์เคลื่อนที่ไปตามเส้นพาธที่สร้าง

ขึ้น 

4. คลิกปุ่ม Free Transform Tool    ที่ทูลบ็อกซ์ 
5. ดรากส์เมาส์หมุนออบเจ็กต์ไปในทิศทางเดียวกับเส้นพาธ 

 
 
 
 
 

7.คลิกปุ่ม Arrow 
Tool 

9.ดรากสเ์มาส์ย้ายออบเจ็กต ์
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6. คลิกเฟรมที่ 15 ของ Layer 1 เพื่อเลือกออบเจ็กต์ ต าแหน่งสุดท้ายขณะที่อยู่ในเลเยอร์ 1 
7. คลิกให้ปรากฏเครื่องหมายถูกที่ Orient to path เพ่ือให้ออบเจ็กต์เคลื่อนที่ไปตามเส้นพาธที่สร้าง

ขึ้น 
8. คลิกปุ่ม Free Transform Tool   ที่ทูลบ็อกซ์ดรากส์เมาส์หมุนออบเจ็กต์ไปในทิศทาง

เดียวกันกับเส้นพาธ 

 
 

คลิกเฟรมที่ 1 ของ Layer 2 

ดรากสเ์มาส์หมุนออบเจ็กต ์

คลิกให้ปรากฏเครื่องหมายถูก
ที่ Orient to path 

คลิกปุ่ม Free Transform Tool 

คลิกเฟรมที่ 20 ของ Layer 2 

คลิกปุ่ม Free Transform Tool 

ดรากส์เมาส์หมนุออบเจ็กต์ 
คลิกให้ปรากฏเครื่องหมายถูก
ที่ Orient to path 
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จากนั้นลองทดสอบภาพแอนิเมชันที่เราสร้างข้ึนมาโดยการ กด <Ctrl+Enter> 

 
 
 

การสร้างแอนิเมชันในลักษณะ Mask Layer คือ การสร้างแอนิเมชันโดยแสดงภาพภายใน 
ขอบเขตที่ก าหนดไว้ซึ่งมีลักษณะเหมือนกับการส่องไฟลงบนเลเยอร์ที่ได้ถูก Mask ไว้ 
 ดังนั้นจึงต้องมีอย่างน้อย 2 เลเยอร์ เลเยอร์หนึ่งไว้ส าหรับใส่ข้อมูลที่จะถูก Mask เช่น ออบเจ็กต์ ภาพ 
ซ่ึงสามารถเห็นข้อมูลที่อยู่ในเลเยอร์นี้ได้ ก็ต่อเมื่อได้มีการน าข้อมูลของอีกเลเยอร์หนึ่งจะท าการ Mask มาวาง
ซ้อนทับหรือเคลื่อนที่ผ่าน จึงสามารถเปรียบได้ว่าเลเยอร์ที่จะท าการ Mask นี้ เป็นเสมือนล าแสงไฟที่ส่องลงไป
ยังข้อมูลของเลเยอร์ที่จะถูก Mask นั่นเอง 
 ตัวอย่างต่อไปนี้จะท าการสร้างแอนิเมชันในลักษณะ Mask Layer โดยเลเยอร์ ที่ 1 ที่จะถูก Mask ได้
มีข้อมูลเป็นรูปวงกลมก็จะเคลื่อนส่องผ่านไปที่รูปภาพ ส าหรับขั้นตอนการท างานสามารถท าได้ ดังนี้ 

1. คลิกเมนูค าสั่ง  Modify เลือกค าสั่ง Document จากนั้นจะปรากฏไดอะล็อกบ็อกซ์ Document 
Properties ขึ้นมา 

2. ที่ Background Color ให้คลิกเลือกสเีทา จากนั้นที่ฉากหลังจะมีพ้ืนเป็นสีด า 
3. คลิกปุ่ม OK เพ่ือยืนยันค าสั่ง 
4.  
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5.  

 
 
 
 
 
 
 
 
 
 
 
 

6. คลิกเมนคู าสั่ง File เลือกค าสั่ง Import แล้วเลือก Import to stage เพ่ือน าไฟล์ภาพ ที่ต้องการ
เข้ามา 

7. คลิกเมาส์ขวาเฟรมที่ 30 และเลือกค าสั่ง Insert  Frame เฟรมทั้งหมดจะมีความยาวจ านวน 30 
เฟรม 

 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมนู Modify > Document 

คลิกเลือกสีเทา 

คลิกปุ่ม OK 

คลิกเมน ูFile > Import >Import to Stage 
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8. คลิกปุ่ม Insert Layer   ที่ไทม์ไลน์ จากนั้นจะปรากฏเลเยอร์ใหม่ ขึ้นมาจ านวน 1 เลเยอร์ 
9. สร้างออบเจ็กต์ ไว้ใน Layer  2  
10. คลิกเมาส์ขวาเฟรมที่ 30 เลือก Insert Keyframe และเลือกค าสั่ง Create Classic Tween เพ่ือ

สร้างการเคลื่อนไหวจนถึงเฟรมที่ 30 
11. ดรากส์เมาส์ย้ายออบเจ็กต์ไปอีกด้านหนึ่งของออบเจ็กต์ที่อยู่ใน Layer 1 

 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมาส์ขวาเฟรมที่ 30 และ 
เลือกค าสั่ง Insert  Frame 
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12. คลิกเมนูค าสั่ง  Window เลือกค าสั่ง Properties ให้ปรากฏเครื่องหมายถูก 
13. คลิกเฟรมไหนก็ได้ระหว่างเฟรมที่ 1 ถึง เฟรม 30 ของ Layer 2 เพ่ือเลือกออบเจ็กต์ ต าแหน่ง

แรกสุดที่อยู่ในเลเยอร์ 2 

สร้างออบเจ็กตไ์ว้ใน Layer 2 

คลิกปุ่ม Insert Layer  

คลิกเมาส์ขวาเฟรมที่ 30  
เลือก Insert Keyframe
และเลือกค าสั่ง Create  
Classic Tween 

 

ดรากสเ์มาส์ย้ายออบเจ็กต ์
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14. ที่ Rotate  ให้คลิกเลือก CW เพ่ือให้ลักษณะการหมุนเป็นแบบตามเข็มนาฬิกา  
15. พิมพ์จ านวนที่ต้องการให้มีการหมุน เป็น 3 Times ออบเจ็กต์จะถูกหมุนตามเข็มนาฬิกาไปเป็น

จ านวน 3 รอบ 
16. คลิกเมาส์ขวาที่เลเยอร์ 2 เลือกค าสั่ง Mask จากนั้นออบเจ็กต์ในเลเยอร์ที่ 1 ที่ได้ถูก Mask ไว้อยู่ 

จะปรากฏขึ้นมาเฉพาะบริเวณที่ออบเจ็กต์ ในเลเยอร์ 2 วางซ้อนทับไว้อยู่เท่านั้น  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
จากนั้นทดสอบภาพแอนิเมชันที่เรา Mask Layer ขึ้นมาโดยการ กด <Ctrl+Enter> 
 

คลิกเฟรมไหนกไ็ด้ของ Layer 2  

คลิกเลือก CW  
พิมพ์จ านวนที่ต้องการให้มีการหมนุ 

คลิกเมาส์ขวาที่เลเยอร์ 2 
เลือกค าสั่ง Mask  



 

 

โรงเรียนตาพระยา  อ าเภอตาพระยา  จังหวัดสระแก้ว  ส านักงานเขตพื้นท่ีการศึกษามัธยมศึกษา  เขต 7 หน้า 143 

 

 
 

 


